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Background: Metabolic reprogramming is an emerging cancer feature that has recently drawn special 
attention since it promotes tumor cell growth and proliferation. However, the mechanism of the Warburg 
effect is still largely unknown. This research aimed to reveal the effects of BarH-like homeobox 2 (BARX2) 
in regulating tumor progression and glucose metabolism in lung adenocarcinoma (LUAD).
Methods: Expression of BARX2 was measured by quantitative real-time polymerase chain reaction (qRT-
PCR) in LUAD cell line and tissues, and the tumor-promoting function of BARX2 in LUAD cells was 
detected in vitro and in vivo xenograft models. The metabolic effects of BARX2 were examined by detecting 
glucose uptake, the production levels of lactate and pyruvate, and the extracellular acidification rate (ECAR). 
Chromatin immunoprecipitation (ChIP) assay and luciferase reporter gene assay were used to identify the 
underlying molecular mechanism of BARX2 regulation of HK2. Further studies showed that transcription 
factor FOXA1 directly interacts with BARX2 and promotes the transcriptional activity of BARX2.
Results: BARX2 was remarkably up-regulated in LUAD tissues and positively linked to advanced clinical 
stage and poor prognosis. In vitro and in vivo data indicated ectopic expression of BARX2 enhanced cell 
proliferation and tumorigenesis, whereas BARX2 knockdown suppressed these effects. Metabolic-related 
experiments showed BARX2 promoted the reprogramming of glucose metabolism. Mechanistically, the 
BARX2/FOXA1/HK2 axis promoted LUAD progression and energy metabolism reprogramming.
Conclusions: In summary, our research first defined BARX2 as a tumor-promoting factor in LUAD and 
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Introduction

Lung cancer is the most common fatal cancer worldwide, 
with over 2.2 million new cases and 1.78 million deaths 
annually (1). Non-small-cell cancer (NSCLC), including 
lung adenocarcinoma (LUAD) and lung squamous cell 
carcinomas (LUSC), accounts for 80–85% of all cases (2). 
Despite advances in cancer treatment, LUAD patients’ 
prognosis is far from satisfying (3). Although treatment 
of LUAD has met with significant progress in recent 
times, the overall survival (OS) of LUAD patients remains 
suboptimal, and valuable molecular biomarkers are lacking. 
Consequently, investigating the underlying pathogenesis of 
LUAD is of significant importance in improving its early 
diagnosis and effective treatment.

Cancer cells are often subjected to various environmental 
stresses such as nutritional deficiencies, hypoxia, and 
acidosis (4), and to fulfil energy and biosynthetic needs, 
they metabolize substrates such as glucose and fatty acids 
through metabolic reprogramming (5). The aberrant 
metabolic characteristic of tumors is considered a 
hallmark of cancer, and cancer cells preferentially utilize 
the glycolytic pathway to produce more pyruvate and 
lactate even when sufficient oxygen is available, leading 
to acidification of the microenvironment (5,6). This 
phenomenon is also termed Warburg effect, in which 
cancer cells grow through differential uptake of glucose 
and amino acids, and increased biosynthesis of lipids, 
proteins, and nucleic acid (7). Warburg effect within the 
tumor microenvironment results in an accumulation of 
lactic acid, which acidifies the tumor microenvironment. 
In recent studies, it has been shown that tumor cells can 
escape immune surveillance due to an accumulation of lactic 
acid (8,9). An increasing number of studies have aimed to 
explore the actual link between metabolic processes and 
oncogenesis (10), and pharmacological agents targeting 
critical regulators of glucose metabolism are in development 
(11,12). It is well known that transcription factors are 
critical in regulating the Warburg effect (13), including p53, 

MYC, and HIF-1α which are responsible for the metabolic 
switch from oxidative phosphorylation to the glycolysis 
pathway in tumor cells.

Homeodomain transcription factors participate in 
tumorigenesis and developmental processes by controlling 
cellular behaviour such as proliferation, adhesion, 
migration, differentiation, and apoptosis (14,15). The 
BarH-like homeobox 2 (BARX2) gene is a homeodomain 
factor in the Bar family located in this critical LOH region 
11q24-q25 region (16,17), and is a crucial regulator of 
cell adhesion, cytoskeleton remodeling, and growth factor 
signaling (18-21). BARX2-deficient mouse embryos show 
defective heteromorphic regeneration (22). Furthermore, 
BARX2 plays a pivotal role in many cancers, particularly 
urinary bladder cancer (23) and gastric cancer (24). 
Although BARX2 is a transcription factor, its role in 
regulating tumor metabolism remains unclear. HK2 is the 
rate-limiting enzyme catalyzes the first irreversible step of 
glycolysis (25). The increasing evidence indicates that HK2 
overexpression and poor prognosis are strongly associated in 
multiple human cancers (26-28). Forkhead box A1 (FOXA1) 
is a member of a group of transcription factors known as 
pioneer factors. FOXA1 binds to condensed chromatin and 
allows subsequent binding of other transcription factors (29).  
Several studies have shown that FOXA1 plays roles oncogenic 
in NSCLC cells (30,31).

In this study, we aimed to determine metabolism-
related transcription factors and discover their underlying 
mechanisms. Our analyses demonstrated that BARX2 is 
frequently upregulated in LUAD, and its upregulation 
is linked to poorer patient survival. In vitro and in vivo 
functional experiments indicated BARX2 may regulate 
cell proliferation and tumorigenicity. Mechanistically, 
our findings suggest that the BARX2/FOXA1/HK2 axis 
promotes LUAD progression and energy metabolism 
reprogramming. We present the following article in 
accordance with the ARRIVE reporting checklist (available 
at https://tlcr.amegroups.com/article/view/10.21037/tlcr-
22-465/rc)

that it may act as a novel prognostic biomarker and new therapeutic target for the disease.
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Methods

Clinical specimens

LUAD and corresponding adjacent normal lung tissues 
were harvested from 2017–2021 at the Department of 
Thoracic Surgery, Jiangsu Cancer Hospital. The samples 
were snap-frozen in liquid nitrogen immediately after 
resection. The study was conducted in accordance with 
the Declaration of Helsinki (as revised in 2013). The study 
was approved by ethics board of Jiangsu Cancer Hospital. 
Informed consent was taken from all the patients.

Cell culture

All cell lines [PC9, A549, NCI-1975, NCI-H1299, and human 
bronchial epithelial cell (HBE)] were purchased from the 
Shanghai Institute for Biological Science, China. PC9, A549, 
NCI-1975, and NCI-H1299 cells were cultivated in DMEM 
(KeyGene, Nanjing, China) with high glucose (4.5 g/L)  
and 10% fetal bovine serum, and HBE cells were cultivated in 
RPMI 1640 (KeyGene, Nanjing, China), supplemented with 
10% fetal bovine serum. All cell lines were maintained in a 
humidified incubator at 37 ℃ (5% CO2).

Tissue microarrays (TMAs) and immunohistochemistry 
(IHC)

LUAD TMAs, obtained from Shanghai Outdo Biotech 
Co. Ltd. (Cat. No. HLugA180Su04) was analyzed for 
BARX2 expression. The pathologic stage was determined 
according to the Union for International Cancer Control 
(UICC) TNM staging system (8th edition). The sections 
were incubated with an anti-BARX2 antibody (Clone ARG-
10900; arigo Biolaboratories, Shanghai, China; 1:1,000) 
and the IHC scores were calculated according to intensity 
and percentage of positive cells. The staining intensity was 
scored as following: 0 (negative), 1 (weak), 2 (moderate), 
or 3 (strong). The H score (percentage of positive cells 
multiplied by respective intensity scores) was used as the 
final staining score (a minimum value of 0 and a maximum 
value of 300).

IHC assays were performed as standard protocols. 
In brief, mouse tissue sections were deparaffinized in 
xylene and rehydrated in graded alcohol (100%, 96%, 
70%). Endogenous peroxidase activity was blocked by 3% 
hydrogen peroxide incubation and antigen extraction, while 
the antibody used for immunostaining was the anti-BARX2 
antibody.

RNA extraction and quantitative RT-PCR

Total RNA was isolated using Trizol reagent (Invitrogen) 
from cells or tissue samples according to the manufacturer’s 
guidelines. Relative RNA level was measured using the 
SYBR Select Master Mix (Applied Biosystems, Cat: 
4472908. KeyGEN, Nanjing, China) by quantitative real-
time polymerase chain reaction (qRT-PCR), using GAPDH 
as endogenous control. The relative amount levels of RNA 
were calculated using the comparative 2−ΔΔCT method. All 
primer sequences are listed in Table S1.

Western blotting

Western blot assays were performed according to the 
manufacturer’s protocol (32). Anti-β-actin antibody (Clone 
3700; Cell Signaling Technology, Danvers, Massachusetts, 
USA; 1:1,000) was used as a loading control. The antibodies 
were purchased from the following manufacturers: anti-
BARX2  (Clone ARG-10900; arigo Biolaboratories, 
Shanghai, China; 1:1,000), anti-FOXA1 (Clone 53528S; 
Cell Signaling Technology, Danvers, Massachusetts, 
USA; 1:1,000), anti-HK2 (Clone 2867T; Cell Signaling 
Technology, Danvers, Massachusetts, USA; 1:1,000).

Plasmid vectors and siRNAs transfection

Plasmid vectors or siRNAs were transfected with 
Lipofectamine™ 3000 Transfection Reagent (Invitrogen, 
CA, USA) or Lipofectamine RNAiMAX (Invitrogen, 
CA, USA), respectively, according to the manufacturer’s 
guidelines. The specific siRNA and transfection plasmid 
vectors were purchased from RiboBio. All siRNA sequences 
are shown in Table S2.

Cell proliferation and migration/invasion assays

After 24 hours (h) of transfection, cells were harvested for 
assessment of cell proliferation, which was then examined by 
a cell counting kit-8 (CCK-8). Cells were plated overnight 
in 96-well plates at a controlled density of 2,000 cells per 
well, then CCK-8 (10 μL/well) was added to each well 
before incubation for 2 h. The reaction products were 
measured at 450 nm according to the manufacturer’s 
instructions. xCELLigence analysis system (RTCA) was 
performed to monitor real-time cell proliferation, and 
8,000 cells per well were added on E-plates 16, with the 
proliferation curve tested every half hour for cell index up 
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to 90 h. For the EdU incorporation experiment, the Cell-
Light™ EdU Apollo®488 In Vitro Imaging Kit (RiboBio, 
Guangzhou, China) was used and the assay was performed 
according to the instructions. To calculate the number of 
cells: Open ImageJ software, choose File->Open (select the 
image to Analyze), and Plugins->Analyze->CellCounter. 
First click Initialize, and then select the cell types to be 
counted respectively. Define the blue one as Type 1 and 
the green one as Type 2. Select Type 1 and click the blue 
dot in the picture one by one, and the total number of cells 
will be displayed in the box after Type 1. For migration/
invasion assays, 5×104 cells were seeded on Transwell kits 
(8 mm PET, 24-well Millicell) or Matrigel-coated inserts 
(BD Biosciences, Bedford, MA, USA). After 24 or 48 h 
of incubation, cells were fixed with methanol and stained 
with 0.1% crystal violet, imaged, then counted under the 
microscope. To calculate the number of cells: Open ImageJ 
software, go to Type ->8-bit to change the Image from RGB 
to 8-bit, then go to Edit -> Invert, then Image -> Adjust 
-> Threshold... To open the threshold window and set the 
threshold. Adjust the Threshold through the Threshold 
window Threshold, and the cells whose brightness exceeds 
the Threshold will be counted. After setting, click the 
Apply button to Apply it to the picture. If two, three or 
more cells are found to overlap, you can separate the cells 
using the Watershed method by going to Process -> Binary 
-> Watershed. Then click Analyze -> Analyze Particles..., 
set the nucleus size, select display outline or other options. 
Click OK to analyze these points of interest. Three 
Windows will pop up, namely Summary, Results and ROI 
Manager, summarizing the total number of these points 
(nucleus) and various parameters of each point (such as 
area, average value, width, height, etc.). Each point can be 
manipulated (add or delete, etc.) through ROI Manager. 
Finally, you can see the total number of cells in the image in 
the Summary Windows. Each experiment was determined 
in triplicate, independently.

Metabolic assays

A Glucose Uptake Assay Kit (Abcam, Cambridge, UK), 
L-lactate Assay Kit (Abcam, Cambridge, UK), Pyruvate 
Assay Kit (Abcam, Cambridge, UK), and Seahorse XF 
Glycolysis Stress Test kit (Agilent, Beijing, China) were 
used for detecting glucose, lactate, pyruvate, and ECAR, 
respectively, and performed according to the standard 
protocols. Cells were seeded in 6-well plates and cultured 
overnight, before the supernatant was collected, and glucose, 

lactate, and pyruvate were measured. For ECAR detection, 
cells were seeded in XF 24-well plates with 1×104 cells and 
starved overnight. ECAR was monitored by the Seahorse 
XF 24 Extracellular Flux Analyzer (Agilent, Beijing, China). 
The results were normalized to the protein content, and 
each experiment was determined in triplicate independently.

Chromatin immunoprecipitation (ChIP)

ChIP assays were performed by ChIP Assay Kit (Sigma-
Aldrich) according to the manufacturer’s protocol (32). 
We used 5 μg anti-BARX2 antibody or 5 μg anti-FOXA1 
antibody for each reaction, and 5 μg mouse IgG (Abcam; 
Cat: ab-150115) was applied as the control. The purified 
ChIP DNA samples were subjected to PCR amplification. 
All specific primer sequences are listed in Tables S3. 
GAPDH was used as control.

Luciferase reporter assay

Luciferase reporter assays were assessed by the Dual-
Luciferase Reporter Assay System (Promega, Madison, WI, 
USA). The 3'UTR of FOXA1 or BARX2 containing the 
predicted binding site for BARX2 or HK2 was cloned into 
a pGL4-basic luciferase reporter vector. CMV-Renilla was 
applied as control. The luciferase activity was measured 
by Firefly/Renilla value. Transfection was performed 
using Lipofectamine™ 3000 Transfection Reagent 
(Invitrogen, CA, USA) according to the manufacturer’s 
recommendations.

Xenograft model

To avoid possible effects of sex on mice survival, tumor 
growth, and tumor implantation response, mice of the 
same sex were used. In comparison to male mice, female 
mice are more docile and easier to work with. Twelve 
female nude BALB/c mice purchased from Nanjing 
Medical University at 4–6 weeks and in good growth 
condition were randomly divided into two groups. PC9 
cells were cultured in large dishes until logarithmic 
growth phase and transfected when the density reached 
70–80% with BARX2 interference plasmid (sh-BARX2) 
and control plasmid (sh-NC) respectively. Cells were 
then counted 48 h after transfection following trypsin 
digestion, washed with phosphate buffered saline (PBS), 
and resuspended in serum-free medium. We then selected 
1×107 cells and suspended them in PBS to construct a 
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subcutaneous lotus tumor model. Mice were housed in 
485×350×200 mm cages and were fed with a full-price pellet 
diet under conditions of free water, room temperature  
22±2 ℃, humidity 50–60%, and a well ventilated 12:12 h  
light/dark cycle. Tumor longitudinal and transverse 
diameters were measured weekly, and tumor volume (TV) 
was calculated by the formula: TV =1/2 × longer diameter × 
shorter diameter2. The health of the animals was monitored 
twice a day during the feeding period, and no adverse events 
were observed. At the start of the experiments animals 
weighed [mean ± standard deviation (SD)] 17.8±0.3 grams.  
Nude mice were sacrificed 6 weeks after cell injection, the 
tumor was excised, weighed, and retained for subsequent 
experiments .  Experimenters  were bl inded to the 
pharmacological treatment while processing data and making 
exclusion decisions. Animal experiments were approved by the 
ethics board of Nanjing Medical University (No. 2018-122),  
in compliance with Chinese guidelines for the care and use 
of animals. The mean value was expressed as mean ± SD, 
the inter-group analysis was statistically processed by t-test, 
and the results were statistically analyzed by SPSS (Statistical 
Package for the Social Science) 22.0. 

Statistical analysis

All statistical data analyses were performed with SPSS 
22.0 and the data visualization using GraphPad Prism for 
Windows v.8.0. The results are presented throughout as 
mean values ± SD from the three experiments independently. 
The Student t-test identified the continuous variable between 
the two groups or more than two groups, and P value <0.05 
was considered statistically significant difference.

Results

BARX2 is highly expressed in LUAD tissues and correlates 
with poorer prognosis

To evaluate the role of BARX2 in LUAD, we first compared 
its mRNA expression between 60 LUAD and corresponding 
non-tumor tissues by qRT-PCR. These studies revealed 
that BARX2 expression was remarkably higher in 97% 
(57/60) of LUAD tissues (Figure 1A). We then assessed 
whether BARX2 expression was up-regulated in LUAD cells 
compared with HBE by Western blot and qRT-PCR (Figure 
1B,1C). The The Cancer Genome Atlas (TCGA) dataset 
indicated that BARX2 expression was significantly higher 
in LUAD samples than in non-neoplastic lung samples 

(P<0.001) (Figure 1D). Similarly, BARX2 was also markedly 
higher expressed in 57 LUAD samples than matched 
non-neoplastic lung samples (P<0.001) (Figure 1E). The 
receiver operating characteristic (ROC) curves indicated 
that BARX2 could distinguish LUAD tissue from normal 
lung tissue with confidence interval (CI) =0.839–0.905 (area 
under the ROC curve, 0.872) (Figure 1F). Furthermore, the 
high or low BARX2 expression of LUAD from the TCGA 
database was defined as a value in the top quartile or bottom 
quartile of the set, respectively. The overall survival (OS) 
analysis of patients indicated that high BARX2 expression 
was associated with poor OS (P=0.043) (Figure 1G). 

IHC assays were performed on TMAs to detect the 
protein expression of BARX2 in 92 human LUAD tissues 
and 88 adjacent non-neoplastic lung tissues. IHC images of 
one patient were presented (Figure 1H), and results showed 
that staining scores of BARX2 were higher in cancer tissues 
(P<0.001, Figure 1I). Combined with the patients’ clinical 
information, the expression of BARX2 was higher in 
patients with more advanced TNM stage (stage I–II vs. III–
IV, P<0.001, Figure 1J), T stage (T1-2 vs. T3–T4, P<0.001, 
Figure 1K), N stage (N0 vs. N1, P<0.001, Figure 1L), and 
lymph node metastasis (P<0.001, Figure 1M). By ranking 
the expression of BARX2 in 92 tissues from high to low, 
we defined the ‘high BARX2 expression’ group (n=46) and 
the ‘low BARX2 expression’ group (n=46) according to the 
median level of BARX2 to explore the prognostic significance 
of BARX2 in LUAD. Survival analysis showed patients with 
high BARX2 expression had a more dismal OS than patients 
with low BARX2 expression (P<0.001, Figure 1N). 

Together, these data demonstrated BARX2 was highly 
expressed in LUAD tissues in comparison to adjacent non-
neoplastic lung tissue and was associated with poor outcomes. 

Knockdown of BARX2 inhibited LUAD cell proliferation 
and progression in vitro and in vivo

To explore the biological function of BARX2 in LUAD 
cells, BARX2 was knocked down by transfecting siRNAs-
BARX2 into PC9 cells; the successful transfection was 
verified by qRT-PCR and Western blot (Figure 2A,2B). 
The results of CCK8 (Figure 2C), RTCA (Figure 2D), and 
EdU staining assays (Figure 2E,2F) showed that silencing 
of BARX2 significantly suppressed the proliferation of 
PC9 cells. In addition, Transwell and Matrigel assays were 
utilized, measuring the greatly inhibited migration and 
invasion abilities in siRNAs-BARX2 groups (Figure 2G,2H). 
Moreover, we transfected plasmids overexpressing BARX2 



Xie et al. BARX2/FOXA1/HK2 axis promotes LUAD1410

© Translational Lung Cancer Research. All rights reserved.   Transl Lung Cancer Res 2022;11(7):1405-1419 | https://dx.doi.org/10.21037/tlcr-22-465

10
9
8
7
6
5
4
3
2
1
0

−1
−2

Fo
ld

 c
ha

ng
e 

of
 B

A
R

X
2 

m
R

N
A

 
ex

pr
es

si
on

 (t
um

or
 v
s.

 n
or

m
al

) Upregulation 95% (57/60)
12

10

8

6

4

2

0

R
el

at
iv

e 
m

R
N

A
 e

xp
re

ss
io

n 
of

 B
A

R
X

2

Cell lines

PC9 1975 1299 A549 HBE

PC9 1975 1299 A549 HBE

BARX2

Actin

8

6

4

2

0Th
e 

ex
pr

es
si

on
 o

f B
A

R
X

2 
lo

g 2
 (F

P
K

M
 +

 1
)

***

Nomal Tumor

10

8

6

4

2

0Th
e 

ex
pr

es
si

on
 o

f B
A

R
X

2 
lo

g 2
 (T

P
M

 +
 1

)

***

Nomal Tumor

1.0

0.8

0.6

0.4

0.2

0.0

S
en

si
tiv

ity
 (T

P
R

)

BARX2 
AUC: 0.872 

CI: 0.839–0.905

0.0  0.2  0.4  0.6  0.8  1.0
1–Specificity (FPR)

1.0

0.8

0.6

0.4

0.2

0.0

S
ur

vi
va

l p
ro

ba
bi

lit
y

Overall survival 
HR =1.34 (1.01–1.79) 
P=0.043

0    50  100 150 200 250
Time, months

Low
High

BARX2

Patient (T3N1M0)

Tumor Para-tumor

500

400

300

200

100

0IH
C

 s
co

re
s 

of
 B

A
R

X
2

Para-tumor Tumor

**
500

400

300

200

100

0IH
C

 s
co

re
s 

of
 B

A
R

X
2

I-II III-IV

**
500

400

300

200

100

0IH
C

 s
co

re
s 

of
 B

A
R

X
2

T1–2 T3–4

**

500

400

300

200

100

0IH
C

 s
co

re
s 

of
 B

A
R

X
2

N0 N1

**

500

400

300

200

100

0IH
C

 s
co

re
s 

of
 B

A
R

X
2

Negative Positive

**

Lymph node metastasis

100

80

60

40

20

0

P
er

ce
nt

 s
ur

vi
va

l Low
High

BARX2

0         20        40        60        80
Overall survival, months

Log-rank P<0.001

A B C

D E GF

H I KJ

L NM

Figure 1 BARX2 is upregulated in LUAD tissues and positively correlates with aggressive clinical characteristics. (A) BARX2 expression 
in LUAD tissues determined by RT-PCR. (B,C) The expression of BARX2 in LUAD cell lines is higher than HBE. (B) qRT-PCR. (C) 
Western blot. (D,E) The mRNA expression of BARX2 (D) in normal tissues and tumor tissues and (E) in paired tissues. (F) A ROC curve 
to test the value of BARX2 and to identify LUAD tissues. (G) Kaplan-Meier curve for OS in LUAD based on BARX2 expression levels. (H) 
Representative IHC staining images in TMAs were shown. (I) The BARX2 staining score was up-regulated in LUAD compared with that 
in adjacent normal tissues (P<0.001). (J-M) The BARX2 staining score was positively correlated with (J) TNM stage (P<0.001), (K) T stage 
(P<0.001), (L) N stage (P<0.001), and (M) lymph node metastasis (P<0.001) LUAD patients. (N) Patients with high expression of BARX2 
have poor OS in LUAD (P<0.001). **, P<0.01; ***, P<0.001. HBE, human bronchial epithelial cell; LUAD, lung adenocarcinoma; qRT-
PCR, quantitative real-time polymerase chain reaction; FPKM, fragment per kilo base per million mapped reads; TPM, transcripts per 
million; ROC, receiver operating characteristic curve; TPR, true positive rate; FPR, false positive rate; CI, confidence interval; AUC, area 
under ROC curve; OS, overall survival; IHC, immunohistochemistry; TMAs, tissue microarrays.

into A549 cells. The results showed that overexpression 
promoted the proliferation, migration, and invasion of A549 
cells (Figure S1A-S1E). 

To investigate the tumorigenic effects of BARX2 in vivo 
using xenograft tumor models, PC9 cells transfected with 
NC-shRNA or BARX2-shRNA were injected into nude 
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mice. The results indicated that BARX2-deficient PC9 cells 
dramatically inhibited tumor growth (volume and weight) 
(Figure 2I-2K). IHC analysis revealed that tumors derived 
from sh-BARX2 transfected cells showed less staining of 
BARX2 than those in the sh-NC group (Figure 2L).

BARX2 contributed to the Warburg effect in LUAD cells

We performed GSEA using the low-BARX2 and high-
BARX2 expression datasets to identify the potential 
function of BARX2 in LUAD, and multiple GSEA showing 
glycose metabolism-related pathways (Table S4). It is well 

known that metabolic reprogramming plays a pivotal role 
in tumorigenesis and is commonly observed in multiple 
cancers (7,33,34). Metabolic reprogramming is considered 
an emerging hallmark of cancer (4,35). Tumor cells provide 
adenosine triphosphate (ATP) for growth mainly through 
glycolysis and biomolecules for cell replication through the 
pentose phosphate pathway (36,37). Moreover, even under 
adequate oxygen conditions, tumor cells preferentially use 
glycolysis to produce high levels of secreted lactate, which 
is known as the Warburg effect (Figure 3A). Consequently, 
we hypothesized that BARX2 might be a key factor for 
metabolic reprogramming in LUAD cells. As expected, the 
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Figure 2 Knockdown of BARX2 inhibited proliferation and progression in vitro and in vivo. (A,B) Two specific siRNA (si1 and si2) of BARX2 
were designed and synthesized, and the transfection efficiency in PC9 cells was measured by (A) qRT-PCR and (B) Western blotting. (C-F) 
CCK-8 (C), RTCA (D), and EdU (E,F) staining assays indicated knockdown of BARX2 inhibited growth of PC9 cell lines, respectively. 
(G,H) Transwell (G) and Matrigel (H) assays were used to test the migration and invasion ability of PC9 cells after knockdown expression 
of BARX2, respectively. After migration/invasion, the remaining cells on the top filter were washed off, and the filters were fixed in 4% 
methanol for 30 minutes. Filters were washed again in PBS before staining in 0.1% crystal violet for 30 min and then counted under the 
microscope. (I) Images of xenograft tumors derived from nude mice bearing PC9 cells of different groups. (J) Tumor volume was measured 
every week after injection. (K) Tumor weight was measured after resection of xenograft tumors. (L) Immunohistochemistry of tumor 
nodules by specific antibody were shown. *, P<0.05; **, P<0.01; ***, P<0.001. qRT-PCR, quantitative real-time polymerase chain reaction; 
OD, optical density; RTCA, real time cellular analysis; CCK8, cell counting kit-8; PBS, phosphate buffer saline.
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results showed BARX2 knockdown leads to a reduction in 
glucose consumption, and lactate and pyruvate production 
(Figure 3B-3D). Next, we explored whether BARX2 could 
directly affect the metabolism of LUAD cells by assaying the 
rate of ECAR (38). Seahorse analysis revealed that ECAR 
was reduced in PC9 cells by inhibiting the expression of 
BARX2 (Figure 3E). In addition, overexpression of BARX2 
significantly promoted glucose consumption and increased 
the production of lactate, pyruvate, and ECAR in A549 cells 
(Figure S2A-S2D). The above results implied that BARX2 
contributed to the Warburg effect in LUAD cells.

BARX2 exerts a cancer-promoting effect by regulating HK2

Reprogramming of glucose metabolism in tumors drives 
the transition to aerobic glycolysis and lactate production 
by regulating the expression and activation of glycolytic 
enzymes, including HK2 (hexokinase 2), glucose transporter 
1/4 (GLUT1/4, SLC2A1/4), GPI (glucose-6-phosphate 
isomerase), PFKL (6-phosphofructokinase, liver type), 

ALDO (aldolase A), GAPDH (glyceraldehyde 3-phosphate 
dehydrogenase), ENO (enolase 1), PKM2 (pyruvate kinase 
M2), and LDHA (lactate dehydrogenase A) (39) (Figure 4A). 
To explore whether BARX2 could affect these metabolism-
related enzymes,  we used qRT-PCR. The results 
demonstrated the mRNA and protein level of HK2 was 
dramatically downregulated by BARX2 siRNA transfection 
(Figure 4B,4C). HK2 is a cancer-related isoenzyme that 
catalyzes the first rate-limiting step of glucose metabolism 
and is a crucial key link in integrating energy production, 
protecting mitochondrial integrity and cell survival (40). To 
confirm whether BARX2 functions via expression of HK2, 
the plasmid overexpress HK2 was transfected into PC9 
cells and treated with si-BARX2 for rescue experiments. 
The results showed that overexpression of HK2 could 
reverse the ability of cell proliferation, migration, and 
invasion compared to the si-BARX2 group (Figure 4D-4F). 
Similar findings were noted for the metabolic phenotype, 
including glucose consumption, lactate, pyruvate, and ECAR 
production (Figure 4G-4J). These results indicated that 
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Figure 4 BARX2 exerts cancer-promoting effect by regulating HK2. (A) Diagram of key enzymes that play key roles in glucose metabolism 
reprogramming. (B) The mRNA expression of metabolism-related genes was measured by qRT-PCR after knockdown expression of BARX2 
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BARX2 promoted tumor progression and glucose metabolism 
reprogramming of LUAD cells via upregulating HK2. 

HK2 is a transcriptional target of BARX2 in LUAD

Transcription factors generally induce or repress gene 
expression through binding to their promoters. Therefore, 
we hypothesized that HK2 is a transcriptional target of 
BARX2. As predicted by the Jaspar Database (41), we 
found a series of putative BARX2 binding sites in the HK2 
promoter with a calculated score of 10.759–5.83968 (Figure 
S3A). To confirm the hypothesis, we performed ChIP assay 
in LUAD cells to determine whether BARX2 could bind to 
the HK2 promoter. A series of three sets of primers were 

designed to correlate with certain sites in the HK2 promoter 
region (Figure 5A). The results showed that a component of 
the -1693 bp -1704 bp (Site1) site of the HK2 promoter was 
enriched in chromosomal DNA precipitated by BARX2 in 
PC9 and A549 cells (Figure 5B,5C). To provide more related 
data, luciferase reporter assays were performed which 
showed the HK2 promoter region was amplified and cloned 
to the pGL4-basic vector and the empty pGL4-basic vector 
as a negative control, respectively. A mutant HK2-Luc 
reporter was also generated (Figure 5D). These data were in 
agreement with the result of ChIP experiments, indicating 
BARX2 markedly promotes the luciferase activity of HK2 
in both PC9 and A549 cells (Figure 5E,5F). These results 
implied that BARX2 was bound to HK2.

si-NC 
si-BARX2 
si-BARX2 + HK2
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Figure 5 HK2 was a transcriptional target of BARX2 in LUAD. (A) Schematic of ChIP analysis in HK2 promoter. (B,C) ChIP analysis 
demonstrated BARX2 was directly bound to the region of the HK2 promoter (sites #1) both in PC9 and A549 cells. (D) Schematic illustration 
of BARX2 binding site on HK2 promoter region and the mutant type were presented. (E,F) Luciferase assays demonstrated overexpression of 
BARX2 remarkably decreased wild type but not mutant HK2 promoter luciferase activity both in PC9 and A549 cells. *, P<0.05; **, P<0.01. n.s, 
not significant; LUAD, lung adenocarcinoma; ChIP, chromatin immunoprecipitation; WT, wild type; MT, mutant.

BARX2 is directly regulated by the transcription factor 
FOXA1 

We sought to identify upstream transcriptional regulators 
that may lead to BARX2 upregulation in LUAD using 
the UCSC Genome Browser and Jaspar Database. We 
predicted a series of transcription factors that bind to the 
BARX2 promoter region. After screening, the transcription 
factor FOXA1 attracted our interest as it can bind and open 
chromatin and trigger target transcription of target genes (42)  
and is also frequently amplified or mutated in human cancers 
(43,44). We verified that silencing FOXA1 could down-

regulate the expression of BARX2 in PC9 cells (Figure 
6A,6B). To understand whether BARX2 was a direct target 
of FOXA1, we analyzed the BARX2 promoter sequence 
using the JASPAR CORE database (Figure S3B). A series 
of three sets of primers were designed to correlate with 
certain sites in the BARX2 promoter region (Figure 6C). 
ChIP assay revealed that FOXA1 is mainly bound to the 
positions −515 to −529 bp (Site2) of the BARX2 promoter 
(Figure 6D). Moreover, the result of the luciferase reporter 
was consistent with the ChIP assay and showed FOXA1 
could markedly promote the luciferase activity of BARX2 
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markedly in PC9 cells (Figure 6E,6F). Taken together, 
our data revealed transcription factor FOXA1 as a critical 
regulator up-regulating BARX2 at the transcriptional level 
in PC9 cells by directly binding to the BARX2 promoter.

Discussion

Lung cancer is still a major health problem due to its 
high incidence and mortality rates. NSCLC accounts for 

85% of all lung cancer (2). Even though extensive lung 
cancer studies have been conducted, the underlying pivotal 
molecular mechanism remains to be fully elucidated, 
hampering therapeutic strategies. As well known, solid 
tumors require high energy and nutrient supplies to 
support their rapid growth and reproduction processes. 
Moreover, glucose is the primary carbon source for 
cancer cells to fuel energy production and biosynthetic 
reactions (45). To survive, tumor cells must adapt to the 
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harsh environments of nutrient stress and reduced pH and 
oxygen by increasing glucose uptake and lactate production; 
known as the Warburg effect (4). The increase in lactate 
production strongly supports diverse cancer cell activities, 
including cell proliferation, angiogenesis, and tumor 
invasion activity, promoting tumor aggressiveness (46,47). 
HIF-1 is a crucial element in the Warburg effect, which 
promotes disconnection of the TCA cycle from glycolysis 
and reductive glycolysis. A decrease in mitochondrial 
activity and an increase in membrane exchangers maintain 
an alkaline pH in the cell, which is favorable to glycolysis 
and cell cycle progression (48,49). Cancer stem cells that 
are inherently drug-resistant are often found in hypoxic 
niches and depend on glycolysis for survival (50). Although 
metabolic reprogramming has long been observed as a 
feature of neoplasia and tumor growth, the mechanism 
driving this process remains unclear. In this study, we 
attempted to target tumor therapy against LUAD from the 
point of glucose metabolism.

The transcription factor BARX2 is a critical member 
of the Bar family of proteins and is expressed in some 
cancers. However, data regarding the role of BARX2 in 
tumorigenesis has been somewhat conflicting (51,52). 
Interestingly, Chen et al. (53) showed the BARX2 expression 
level was down-regulated in NSCLC. Therefore, BARX2 

has attracted our interest for further research. 
In contrast to the study by Chen et al. (53) our results 

showed that BARX2 was frequently up-regulated in LUAD 
tissues compared to non-neoplastic tissues. Furthermore, 
the TCGA database demonstrated that BARX2 may be a 
potential predictive marker for LUAD tissues. In addition, 
clinical analysis revealed that upregulation of BARX2 
correlated with advanced tumor stage and poor prognosis 
of LUAD patients. Moreover, knockdown of BARX2 
significantly inhibited proliferation, invasion, migration, 
and glucose metabolism ability of LUAD cells in vitro and 
in vivo. These data imply that BARX2 plays a vital role in 
promoting cancer progression, metastasis, and glucose 
metabolism of LUAD.

The GSEA results showed BARX2 was related to 
glycose metabolism-related pathways. Tumor cells 
reprogram energy metabolism to facilitate cell growth 
and proliferation, a phenomenon which has been firmly 
established as a classical hallmark of cancer (4). The 
oncogenic metabolic reprogramming is driven by essential 
key enzymes including HK2, GPI, PFKL, ALDO, GAPDH, 
ENO, PKM2, and LDHA (54). Therefore, qRT-PCR and 
Western blotting were performed to validate the series of 
glycolytic enzymes. HK2, one protein remarkably decreased 
by BARX2 knockdown, attracted our interest. HK2 is a 
crucial enzyme that catalyzes the rate-limiting first step of 
glycolysis and is highly up-regulated in multiple human 
tumors (40). In addition, mechanistic investigations found 
that the expression of BARX2 transcriptionally regulated 
HK2. We speculated that BARX2 bound to the HK2 
promoter region promotes LUAD growth and metastasis.

While our study generated important and interesting 
findings, our results should be interpreted with caution. 
First, we found that the expression of BARX2 was up-
regulated in LUAD from TCGA database, then verified 
the up-regulation of BARX2 expression in LUAD samples, 
LUAD tissue microarray, and LUAD cells, and verified 
that BARX2 plays a carcinogenic role in LUAD through 
experiments in vitro and vivo. However, the results by Chen 
et al. (53) were different from ours. We speculated that 
there are several reasons: the LUAD samples we used come 
from different institutions and may be different; in addition, 
the cell lines we selected were different.

In summary, our findings first defined BARX2 as a tumor 
promoter in LUAD and identified the BARX2/FOXA1/HK2 
axis as a pivotal pathway involved in its development and 
progression of LUAD (Figure 7). Targeting this axis could 
be a novel therapeutic strategy against LUAD.

Figure 7 Schematic illustration of BARX2/FOXA1/HK2 
axis promotes LUAD progression and energy metabolism 
reprogramming. LUAD, lung adenocarcinoma.
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